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TOPIC DETAILS

Delete preferences To start fresh in InDesign, delete the existing prefs on opening the 
application: Click the icon in the Dock to open it, then immedi-
ately press Control-Command-Option-Shift all at once. Hold the 
keys down until you get a message asking if you want to delete 
the preferences. Click “Yes.”

Defaults: 
Application specific

Everything you choose while InDesign is open but no document  
is open will become defaults for new documents.

Be sure to change the “Units & Increments” preferences.

Bleed and Slug options  
in Document Setup

Bleed: Creates a non-printing guideline for aligning leeds.
Slug: Creates a space outside the trim on any side of a document 

where you can enter notes for clients, printers, job approvals, etc. 
When printing or making pdfs, you can choose whether these areas 

print or not (in the “Marks and Bleeds” prefs pane). 

Document presets From the File menu, choose “Document Presets.”
Click “New” to set up your ecs. Once you’ve made a preset,  

it is availale in the File menu whenever you need a new doc. 
Use this same dialog box to edit existing presets, delete them, save a 

preset into any folder on your Mac so someone else can load it.
To skip the “New” dialog box when choosing a doc preset, hold 

down the Shift key as you choose it.

Palettes As in Photoshop and Illustrator, press Tab to hide all palettes;  
Shift-Tab to hide all but Toolbar and Control bar (or click  
on the Palettes button in the Control bar). 

Dock palettes: Drag the tab (not the title ba) to the bottom of 
another palette. Now both palettes will move together.

Group or Ungroup palettes: Drag the tab of one palette into the gray 
area next to the tab of another palette. 

Collapse individual palettes to side tabs: Grab the tab (not the title 
bar) and drag it to the left or right side. 

Collapse a group of palettes to side tabs: Option-grab the tab and 
drag it to either side.

Open or close all side tabs: Option-click on a forward tab.  
or press Command-Option-Tab key.

Gr oundwor k , L BOs, and Color
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Workspace Save the arrangement of palettes as custom workspaces for different 
projects. Use the “Workspace” option in the Window menu.

Undo Undo saves everything you do, even after you Save. This hogs 
memory. “Save As” and replace the file regularly, and always “Save 
As” after you do a big change, such as delete a number of pages.

Defaults:  
Document specific

In an open document, make sure nothing is selected (click once on 
the Pointer tool, then click a lank area, or press Command 
Shift A). Anything you choose from any menu, palette, o dialog box 
hile nothing is selected becomes the default. 

LBOs Lines, boxes, and ovals: defaults, borders, fills, polygons, ends, 
gaps, joins, etc. Remember to take advantage of the temporary 
document-ecific defaults.

Align stroke feature: center, inside, or outside bounding box.
Apply rounded or fancy 

Custom strokes; save as style (won’t save color, gap color, etc.).

Eyedropper tool Transfer properties to other objects.
Either: First get the Eyedropper tool. Click on one object to pick up 

its properties, then click on another object to transfer the chosen 
properties.

OR: First select an object/s with the Pointer tool. Then get the 
Eyedropper tool and click on an unselected object whose 
properties you want to transfer to the selected object/s.

Color and Swatches  
palettes

   Tips for using

Color palette: Used for individually applied color. You can edit a 
Swatches color without affecting the Swatch.

Shift-click the color bar at the bottom of the palette to switch color 
mode, or choose a different mode from the menu.

Swatches palette: Used for globally applied color styles.

Any colors you create in the Color palette are non-global and  
will not appear in the Swatches palette; they are considered  
“unnamed colors.” 

However, you can either use the Color palette to make a color  
and then immediately choose “Add to Swatches,”  
or drag the color box from the Color palette and drop it  
on the Swatches palette. 

or from the Swatches palette menu, choose “Add Unnamed Colors,” 
which will add all unnamed colors in the document to the 
Swatches palette. 

Once a color is in the Swatches palette, you can edit the color  
and it will affect every object that has that color applied. 

To edit an individual object that has a Swatch color applied:  
Use the Color palette.

To apply color to an UNselected object: Drag a color from the 
Swatches palette and drop it in the middle of a shape or directly 
on a border of a shape.

Tip: Double-click the 
Eyedropper tool  

in the Toolbar to see  
the amazing options.
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Tips using the Color  
and Swatches palettes

—continued

Rename a swatch: Doule-click a swatch; uncheck “Name with 
Color Value.” Type in your own name for the color.

Edit a color without applying it to a selected object:  
Command-Option-Shift doule-click a swatch.

Reorder swatches: Press-and-drag to other positions.
Check the CMYK or RGB values: Hover over the color swatch.
Delete all unused swatches: From the menu, choose “Select All 

Unused.” Go back to the menu and choose “Delete Swatch.”
Out of gamut: Click the tiny color box near the “out of gamut” 

symbol to switch to the nearest color in gamut.
Importing colors: From the Swatches menu, choose “New Color 

Swatch.”  From the “Color Mode” menu inside the dialog box, 
choose your mode. Shift-click or Command-click to select and 
add more than one. Click the  “Add” button.

Import colors from another document: From the Swatches menu, 
choose “Load Colors.” Choose the other document.

Gradients Gradient palette: Like the Color palette, it applies and edits 
gradients individually. It’s not aive until you select an object  
to which you can apply a gradient.

 Drag swatches to the stop points.  
or click on a stop point; then Option-click on a Swatch.

 To switch the end colors, click  the “Reverse” button.
Swatches palette gradients: Add a gradient to the Swatches palette 

so you can apply it globally (from the menu, choose “New 
Gradient Swatch”). 

 Click a stop point, then either edit a color or choose “Swatches” 
from the Stop Color menu to choose a color. 

Add more stop points: Click directly under the gradient bar.
Delete stop points: Drag them off the bottom of the palette.

Gradient tool This tool applies the last gradient created in the Gradient palette  
or the selected gradient swatch.

With the lack Pointer tool, select an object or multiple objects. 
Then get the Gradient tool and press-and-drag across an object 
or collection of objects. 

Libraries Store often-used images and text in a Library. Add text labels to 
each piece so you can later search and make subsets.

Text you put into a Library will include the style sheets, tale 
formatting, etc. 

Make separate Libraries for different types of projects. Give Library 
files (.indl) to co-workers.
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View the document Reduce or enlarge the page: Press Command – or Command +
Temporary magnifying tool: Command Spacebar; press-and-drag 

around an area to enlarge that area to fill the screen.
Fit page in window: Command 0 (zero).
Fit spread in window: Command Option 0 (zero).

View two windows  
of same page

From the Window menu, choose “Arrange,” then choose  
“New Window.” Go back to the same menu and choose  
“Tile” to set the two windows side by side.

Navigator palette Great for use with large pages or two windows of the same project. 
Use its menu to choose to see all spreads or just the aive spread  

in the palette.

Rulers To change ruler increments: Control-click on either vertical  
or horizontal ruler, then choose from the pop-up menu.  
This will also change the increments in all measurement boxes.

To change the zero point: Press-and-drag the corner.
To change the origin: Use the contextual  menu, as above,  

or go to the preferences and use the “Origin” option in  
the “Units & Increments” pane.

To pull down a ruler across both pages of a spread: Hold down the 
Command key after you start to drag the ruler guide. 

Measure tool It’s under the Eyedropper tool. 
To measure anything: Either click two points with the Measure tool 

and you’ll see the measurement in the Info palette that appears, 
or press-and-drag the Measure tool. The measurement line 
disappears when you choose another tool.

To  measure an angle: Drag the first line, then hold down the Option 
key and drag the second line at the angle. 

Transparency palette Apply transparency to selected objects, photographs, graphics,  
or text. See the last page of this handout for a description of the 
modes, used when applying transparency to layered objects.

This is an example of three objects 
overlaid on each othe. Using the 
Transparency palette, I applied the 
Multiply mode to the circle and sta.  

The only difference between this and 
the example to the left is that I grouped 
the circle and sta and then checked the 

“Isoslate Blending” box.

Transparency with “Isolate Blending” applied
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Baseline grid Align baselines of text: The grid resemles ruled notebook paper 
and covers just the page or spread. You must carefully create your 
documents using proportional leading values for everything.

Press Command Option " to display or hide the baseline grid.
Set the values in Preferences under “Grids.”
  “Start” value is how far down from the top of the page the grid 

should start. 
  “Increment Every” value should equal the leading value of your 

body copy.
  “View Threshold” is the magnification percentage of the page  

at which you don’t want to see the grid anymore.
To align text: Use the Paragraph palette and click the “Align to Base-

line Grid” button. If you prefer, then go to the Paragraph palette 
menu and choose “Only Align First Line To Grid.” These ecs 
can be added to a style sheet.

Document grid To align objects: It resemles graph paper and covers the spread and 
the entire pasteboard. Set the values in Preferences under “Grids.”

Press Command " to show or hide the document grid.
If you turn on “Snap to Guides” and “Snap to Document Grid,” the 

grid takes precedence. (The “Snap-to Zone” is set in Preferences 
in the “Guides & Pasteboard” pane.)

Pages palette Add and delete pages, etc. Use the triangle to get the menu.
Important note: The Delete command will delete the page/s selected 

in the palette, not the page isile on the screen!
Re-order pages: In the Pages palette, drag a page or selection of pages 

to a new position.
Select pages: To select contiguous pages, use the Shift key; to select 

non-contiguous pages, use the Command key. 
Selected vs. targeted pages: Pages or spreads that are gray are 

selected  so you can delete them, apply new guides, etc. 
 Pages with highlighted page numbers are targeted—pasted objects 

will land on a targeted page.

In this document I used the tale feature in hich to 
create all the text. I also used the nested styles feature 
to get the bold sans serif style until I typed a colon, 
then it automatically switched to the serif font. 

Tip: If you can’t control the space 
between lines on your text or if 

it is exhibiting puzzling behavior, 
select the text and click the tiny 

icon in the Paragraph palette,  
“Do Not Align to Baseline Grid.”
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Normal
Colors the selection with the lend color, without 
interaion with the base color. 

Multiply
Multiplies the base color by the lend color. The 
resulting color is always darker. Multiplying any color 
with lack produces lack. Multiplying any color with 
white leaves the color unchanged. The effect is simila to 
drawing on a page with multiple magic markers.

Screen
Multiplies the inverse of the lend and base colors. 
The resulting color is always lighter. Screening with 
lack leaves the color unchanged. Screening with white 
produces white. The effect is simila to projecting multiple 
slide images on top of each othe.

Overlay
Multiplies o screens the colors, depending on the base 
color. Patterns or colors overlay the existing artwork, 
preserving the highlights and shadows of the base color 
while mixing in the lend color to reflect the lightness 
or darkness of the original color.

Soft Light
Darkens or lightens the colors, depending on the lend 
color. The effect is simila to shining a diffused spotlight on 
the artwork.
If the lend color (light source) is lighter than 
50% gray, the artwork is lightened, as if it were dodged. 
If the lend color is darker than 50% gray, the artwork 
is darkened, as if it were burned in. Painting with pure 
lack or white produces a distinctly darker or lighter 
area, but does not result in pure lack or white.

Hard Light
Multiplies or screens the colors, depending on the 
lend color. The effect is simila to shining a harsh spotlight 
on the artwork.
If the lend color (light source) is lighter than 
50% gray, the artwork is lightened, as if it were 
screened. This is useful for adding highlights to art-
work. If the lend color is darker than 50% gray, the 
artwork is darkened, as if it were multiplied. This is 
useful for adding shadows to artwork. Painting with 
pure lack or white results in pure lack or white.

Color Dodge
Brightens the base color to reflect the lend color. 
Blending with lack produces no change.

Color Burn
Darkens the base color to reflect the lend color. 
Blending with white produces no change.

Darken
Selects the base or lend color—whichever is darker—
as the resulting color. Areas lighter than the lend 
color are replaced, and areas darker than the lend 
color do not change.

Lighten
Selects the base or lend color—whichever is lighter—
as the resulting color. Areas darker than the lend 
color are replaced, and areas lighter than the lend 
color do not change.

Difference*
Subtracts either the lend color from the base color 
or the base color from the lend color, depending on 
which has the greater brightness value. Blending with 
white inverts the base color values; lending with lack 
produces no change.

Exclusion*
Creates an effect similar to, but lower in contrast than, 
the Difference mode. Blending with white inverts the 
base color components. Blending with lack produces 
no change.

Hue*
Creates a color with the luminance and saturation of 
the base color and the hue of the lend color.

Saturation*
Creates a color with the luminance and hue of the base 
color and the saturation of the lend color. Painting 
with this mode in an area with no saturation (gray) 
produces no change.

Color*
Creates a color with the luminance of the base color 
and the hue and saturation of the lend color. This 
preserves the gray levels in the artwork, and is useful 
for coloring monochrome artwork and for tinting 
color artwork.

Luminosity*
Creates a color with the hue and saturation of the base 
color and the luminance of the lend color. This mode 
creates an inverse effect from that of the Color mode.

 *Fo use with CMYK only.
This is from the Adobe online support; I edited fo clarity.

Blending Modes
Found in the Transparency palette.  


